ERTLab Sequencer
 
Introduction
The ERTLab Sequencer is used to create arrays and sequences for a range of survey configurations.  Because of the complexity of creating sequences for 2D and 3D surveys, the sequencer includes tools to view the electrode locations and array sequences in 3D (Quadrupole List) and to show a half space and geometric factor plot location (Quadrupole View) that provides an idea of the focus of data collected at any given quadrupole. Similarly, because 3D data collection is typically highly redundant and voluminous, QC Tools such as incorporation of reciprocals and removal of duplicates are included. In addition to this help file, most buttons, input boxes and controls have 'tool-tip' help. If you hold the mouse over the control without clicking for slightly more than a second, then a small menu describing the function of the control will be presented.
 
To build a sequence:
            1) Input the electrode locations.  These are usually logically grouped as one or more cables (survey lines or wells) each with one or more evenly spaced electrodes.  
            2) Build a sequence containing one or more array types.  
            3) Save the sequence to be downloaded to a field system or input into a forward model for survey design.
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Menu Bar
File Menu Item
The file menu permits opening and saving files in several formats including ERTLab native format, Electre text format and MPT format. 

Layout Menu Item
 
[image: image2]
 
Unless an existing sequence file has been imported, the place to start is the Layout menu.  First select Cables. The cable entry screen will be presented. Grid and coordinate list are not currently implemented and make sequences is the same as selecting the items from the Sequence menu. Electrodes displays a list of electrodes.
 
Cable Entry
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Electrodes are grouped by Cable (logically equivalent to a survey line, well or physical cable with multiple takeouts). Start with an electrode distribution on the first cable (along the first survey line or in the first well).  Count is the number of electrodes on this cable. To insert a new cable in the layout, specify the number of electrodes for the cable (count), and the spacing. After making changes for any entry please push enter to update the linked parameters. The spacing control updates the X end coordinate unless the borehole checkbox is checked, in which case the Z end coordinate is updated. When the insert button is pushed the electrode distribution is displayed and the logical group is indicated by the electrodes being joined by a line. Alternatively, the start and end of the cable (cable start and cable end) may be set using XYZ coordinates in meters. To insert cables underground the Z value should be negative. Surface is assumed to be 0 and topography is not considered. Topography may be added later in the forward workspace for forward modeling and in the inversion workspace for inversion. 
 
It is possible to include up to two remote electrodes. These are input by selecting the checkboxes and entering the appropriate X, Y and Z coordinates.
The ERTLab coordinate system employs a right-handed coordinate system with 'Z' positive up. For borehole electrodes, the  calculation of the geometrical factor K is influenced by the depth of burial of the electrodes. On insertion, the new cable will is displayed in red in the 3D view window. 
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The 'Move Cable' frame contains buttons that facilitate moving the selected cable. This menu works on the highlighted (red) cable. To highlight a cable double-click on any of its electrodes. The standard displacement is equal to the cable electrode spacing and the cable may be moved in any direction by clicking the appropriate arrow. By holding the [Shift] key the displacement is reduced to one tenth the cable electrode spacing. Holding the [Ctrl] key, results in the standard displacement multiplied by a factor ten. Watch the cable start and end coordinates to see the effect of moving the cable. To re-center the 3D display screen check the Grd. Auto checkbox.
 
The two buttons [image: image5] and [image: image6], flip the cable vertically and horizontally, respectively. These are useful for reversing the cable electrode numbering direction. 
 
[image: image7]
 
 Between the cable definition and move menus is the cable insertion menu. The four buttons on this menu permit inserting a cable, updating its coordinates, removing a cable or removing all of the cables. The update cable button is not active unless some parameter in the cable definition menu has been changed (XYZ start or end, or electrode count or spacing). Update cable and Remove affect the selected (red) cable. Note that insert places a cable according to the parameters in the cable definition area. If this has not been changed from the previous insertion, then the new cable will plot exactly on top of the previous cable and it may not appear that two cables are present. Check the cable count in the lower right corner of the cable entry dialog to determine the number of cables present.

Grid Entry

A different way to insert electrode on a layout is using a grid. User will define max number of columns and max number of rows in a “electrodes matrix”, distance between columns and rows can also be defined (default is 1 m). The button [Grid] will create onto the graph window a grid as specified. Electrodes number would be inserted into cells with left click. Each left click will increment counter of 1, rgth click of about -1. When the insertion is completed click on [Create Elec.] button and the program create a single cable with electrodes specified in the grid. 
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Grid entry
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Single cable created with grid entry mode
3D view
 
[image: image10]
Four parallel cables (16 electrodes per cable) with a surface grid
 
 
A 3D graph picture box is always visible in the lower part of the window.  Some controls are available near the view itself, such as [Zm X] (Zoom in X); [Zm Z] (zoom in Z), Reset and grid controls. Others are available on a separate menu. Other controls near the view are the [Grd. Auto] check box, which recenters the view when switched on, and five boxes that control surface grid display. These boxes control spacing, and extent of the surface grid display. 

Using the mouse the 3D view may be rotated, panned and zoomed. Combinations of left mouse key, right mouse key and the keyboard shift, control (ctrl), and alt buttons perform different functions. These are documented in the table below.
 
	Event
	Key
	Motion.
	Action

	LeftMouseDown
	 
	Horizontal
	Rotate around vertical Axes (Z)

	 
	 
	Vertical
	Rotate around horizontal Axes (X)

	 
	Shift
	Horizontal
	Rotate around Y axes (orthographic)

	RgtMouseDown
	 
	Vertical
	Zoom in / zoom out

	LftMOuseDown
	Ctrl
	 
	Drag Image

	LftMouseDown
	Alt
	 
	Select area

	RgtMouseDown
	Shift
	 
	Adjust focus in perspective view

	DblClick
	 
	Over electrode
	Select cable

	LftMouse
	Shift
	Over electrode
	Toggle elec. Used

	RgtMouse
	Shift
	Over electrode
	Edit electrode coordinates


 
In addition to the mouse controls a menu with certain view options is presented. 
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Switch between orthographic and perspective views using the toggle buttons [Ortho.] and [Persp.] Snap to XY, YZ and XZ views using the push buttons on the right of the menu. Subtle rotations about X, Y and Z axes are possible using the increment buttons or by directly entering an angle. The effect of these controls is as follows: 
[Theta]:           is the angle around X axis (X is horizontal and positive to the right)
[Gamma]:       is the angle around Y axis  (Y is a horizontal line projecting outward from the plane of your computer screen).
[Phi]:               is the angle around Z axis (Z is vertical with positive upward).

In addition these subtle controls are implemented for zoom using the buttons or value entry. Larger values zoom out (make the image smaller) and smaller values zoom in (i.e. the value acts more like a scale factor than a zoom.)
 
Check boxes are available to display different attributes of the cables, electrodes and data window.
 
Cables Checkbox:    Show/hide connection lines between electrodes in cable.
Grid Checkbox:         Show/hide a surface grid spaced as specified in the [Grd. Spc.] text box.
Quad. Checkbox:      Show/hide quadrupole plot points in the graph window.
Box Checkbox:          Show/hide a box at the coordinate extremes in the graph window.
Lbl Checkbox:           Show/hide labels at the corner of the box.
 
In addition the display of electrodes on the cables has several options. Graphical presents the electrodes as dots, electrode ID displays the electrode number at each location,  Cable and electrode ID presents Cable_Electrode numbers at each location and none turns electrode display off.
 
Electrode List
The electrodes list is shown by clicking the “electrodes” menu item from the Layout menu.
 
[image: image12]
 
When scrolling through the electrodes list the selected electrode is highlighted on the 3D View. 
By pressing the left mouse button while holding the ctrl key it is possible to select a group of electrodes. Electrodes inside the selected region will turn blue. Blue electrodes can be set/reset as Roll or Skip. Skip (usd = 0) means that quadrupoles using this electrode will not be scheduled. This is useful for bad electrodes, or when limited time for data collection is available, or when testing array patterns for resolving capability. The roll setting (Roll = 1) is for cable overlap. Quadrupoles where all electrodes with the roll flag set to one will not be inserted in the schedule. Use this option to create a Roll-Along sequence
 
Sequence generator
 
[image: image13]
 
Three items are available on the sequence menu. Make surface sequences is used to create sequences where surface electrodes alone are employed. Make multi-borehole sequences is used when borehole or borehole and surface electrodes are used. View Quadrupole list displays a list of the sequences that have been created. Multi-borehole sequences may only be generated on cables having electrodes with negative 'Z' coordinates. It is recommended that the borehole checkbox be selected when borehole cables are being developed. Separate menus are available to make the interface as intuitive as possible for each survey type.

In many respects the function of the two menus is similar. In each menu toggle buttons are available for various array types. These are arranged across the top of the menu area.  More than 1 array type may be chosen, however for best control it is recommended that only one array type be chosen at a time. In each case the common array terminology 'a' and 'n' is implemented, however 'a' spacing is implemented in terms of the cable electrode spacing. ie for cables having an electrode spacing of 3 m, an 'a' spacing of 1 would represent a 3 m dipole, and an 'a' spacing of 2 would represent a 6 m dipole. 'n' spacing are implemented in the usual manner as multipliers for the 'a' spacing that represent transmitter and receiver separation. The button [image: image14]is used to add a sequence to the list. Each time this button is pressed a sequence based on the parameters chosen is created and appended to the existing sequence list. The sequence list may be viewed at any time by pressing F11, or by selecting the 'View Quadrupole List' menu item. The button [image: image15]is used to completely clear the sequence list. At this time there is no ability to remove only 1 sequence. Finally, kGeom. may be used as a threshold to ignore quadrupoles with small geometric factors. This is useful to avoid wasting time collecting data that will likely have very small received voltages and thus be noisy and unreliable. The default value of '0' writes all quadrupoles to the list regardless of geometric factor.

 
Surface scheme 
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In the surface scheme dipole length ('a') spacings are specified in a list, use of multiple 'a' spacings is facilitated using a simple list. (For a more traditional approach simply specify a single 'a' spacing - e.g. 1 in both the transmitter and receiver areas. Similarly 'n' spacings (nL box) are explicitly requested using the list area. For a short definition of the ‘a’ or ‘nL’ list, is possible to use a very simple syntax: “1:10” means all integer number from 1 to 10, “2:2:10”, means all even number form 2 to 10. 

The arrow checkboxes and common and different cable toggles interact. By toggling common cable, the arrays created have transmitter and receiver dipoles aligned in a single direction (i.e. the transmitter and receiver are arranged in a straight line). If different cables toggle is set then the transmitter and receiver dipoles cannot be aligned in a straight line. The arrows checkboxes are set independently for the transmitter and receiver. The horizontal arrows result in common cable dipoles. The vertical arrows result in dipoles with matching electrode numbers on two separate cables. The diagonal arrows are similar to the vertical arrow except that electrode numbers are incremented or decremented by the 'a' spacing selected. If common cables and the horizontal arrows are chosen then a traditional array, arranged along a survey line is sequenced. If  common  cables and vertical arrows are chosen then the same, aligned, traditional array is arranged perpendicular to the survey lines as shown below. In this case only 16 quadrupoles are created because there are only 16 positions which can supported this aligned, perpendicular array. However if Tx and Rx on different cables is toggled, then 1536 quadrupoles are created, because all the offset perpendicular arrangement are generated as shown in the second figure. The display of transmitter and receiver dipoles shown in these figures is accomplished using the Quadrupole View described below.
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Creation of a simple sequence would include the following steps:
 
[image: image19]
1 – Select the array type using the push buttons (dipole-dipole, wenner etc. - multiple selections are allowed)
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2 – set the transmitter dipole size and direction parameters.
 
[image: image21.jpg]£ Tx and R on common cable:  Twand R on diferent cables

Constarts

Kaeom 0 nfizass

Qe

|





3 – set n list and constraint for geometric factor

[image: image22]
4 – toggle common or X-cable arrays
 
5 – Push the [image: image23]button to generate the sequence.
6 – Push F11 or select View Quadrupole List from the Sequence menu.
7 – Repeat steps 1-5 to generate as many sequences as required.
6 – Save the sequence. 

Examples of array types shown below employ diagonal array development to enhance clarity. The display of transmitter and receiver dipoles shown in these figures is accomplished using the Quadrupole View described below.
 
[Pole – Pole]             Create a Pole – Pole sequence. Remote will be B and N.
 
[image: image24]
Pole-pole,  a = 3,  diagonal 1
 
 
[Pole – Dipole]          Create a Pole – Dipole sequence. Remote will be B.
                                   
[image: image25]
Pole – Dipole, a = 1, nL = 3, diagonal 1 
 
[Line Dipole-Dipole] Create a Dipole – Dipole sequence. 
 
[image: image26]
Dipole – Dipole, a = 1, nL = 1, diagonal 2
 
[image: image27]
Dipole – Dipole, a = 1, nL = 2, diagonal 1
 
 
[Wenner]                                Create a Wenner sequence. Use the transmit parameters and specify every a you need to include in your sequence
 
[image: image28]
Wenner, a = 1, diagonal 1
 
[Wenner Schlumberger]       Create a Wenner Schlumberger sequence. Use the transmit parameters and nL
 
[image: image29]
Wenner Schlumberger, a = 1, nL = 3, horizontal
 
[Gradient Array]                    not yet implemented            
 
[Parallel Dipole Dipole]       not yet implemented
 
 
Create a Roll – Along sequence
 
In order to create a Roll-Along sequence, set the roll flag of electrodes that will not repeat to 1, meaning that quadrupoles with all non-remote electrodes with Roll flag set to 1 will not be included in the list.
 
In the case of a 32 electrode cable, 
 
-          to “move the cable” every  2 electrodes, in order to create a roll – along sequence, electrodes from 1 to 32 must have the roll flag to 1
-          to “move the cable” every 16 electrodes, in order to create a roll – along sequence, electrodes from 1 to 16 must have the roll flag to 1
To show the plot locations as shown see Quadrupole view below.
 
 
[image: image30]
32 electrodes. Wenner sequence – Roll-Along of 16 electrodes 
 
 
Quadrupole List
 
[image: image31]
 
The quadrupole list is available by pressing F11 or selecting View Quadrupole List from the Sequence menu. The transmitter (red electrodes) and receiver (green electrodes) dipoles are highlighted by selecting using the mouse any quadrupole in the list.
 
Quadrupole View
Quadrupole view is selected by checking the quad. checkbox. An idea of focus for any quadrupole is provided by plotting a single circle representing each quadrupole in 3D space following a simple rule. In surface configuration (all the electrodes have Z coordinate zero or positive), the XY coordinate of each quadrupole is determined by an average over the XY coordinate of the non-remote electrodes in quadrupoles and the Z coordinate is determined by level order. The levels are sorted by the absolute value of the K geometric factor.
In cross-line configuration (at least one electrode has a negative Z coordinate), the XYZ coordinates are determined following this heuristic rule: the quadrupole plot point lies in the line joining the mid point of the current dipole and the potential dipole, quadrupoles are sorted by the absolute value of K, lower K plots closer to current dipole. The idea is to provide an indication of coverage, resolution and redundancy available in the sequence generated.
 
[image: image32]
Heuristic representation of Cross-Hole Dipole - Dipole sequence (a=1, 2, 3)
 
[image: image33]
Heuristic representation of Cross-Hole Dipole Dipole sequence 
(a=1. A=1, B=2, MN=16-17  31-32)
 
 
[image: image34]
Linear Dipole-Dipole a = 1 nL = 5, all directions
 

Tools
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The tools menu is accessed from the main menu bar. The tools are arranged in two categories. The first is optimization. Some resistivity meters can carry out measurements using multiple channels. That is data from multiple receiver dipoles may be collected during energization of one transmitter dipole. In most cases appropriate arrangement of the schedule file is required to implement this functionality. The Optimize button in ERTLab is specific to the IRIS Syscal which requires dipoles on sequential channels to be linked by a common electrode.

The second category is  for QC and  to  remove redundancy. If multiple  types of sequences have been generated, it is possible that some duplicates were created. pressing the remove duplicates button removes all duplicate readings. Due to the high data volumes typically collected for ERT, traditional, manual QC is practically impossible. One useful trick is to collect reciprocal data. Reciprocal data have the transmitter and receiver dipoles swapped. Reciprocity states the two readings should be identical. Comparing reciprocal data can identify such problems as high contact resistance, cultural noise, intermittent connections and instrumentation problems such as poor grounding or failed components. We highly recommend that data intended for interpretation through inversion be collected reciprocally. ERTLab solver provides tools for analyzing the reciprocal data for problems.
 
Input Output options
 
[image: image36]
 
The Open and Save options are accessed from the File menu on the main menu bar. The four options indicated save ASCII files. Cables saves only the electrode locations. ERTLab format is for the ERTLab solver. Electre format is for the Syscal instrument manufactured by IRIS instruments of France. MPT format is for the EIT2000 series of resistivity meters manufactured by Multi-Phase Technologies, LLC in the United States.
 
Multi-borehole scheme  
[image: image37]
 
In the multi-borehole scheme dipole length ('a') spacings is set once and is the same for both transmitter and receiver.  Use of multiple 'a' spacings is facilitated through a simple list. (while developing an understanding of sequencer operation it is recommended that a single 'a' spacing - e.g. 1 is chosen as this vastly decreases the number of quadrupoles generated). 'n' spacings are explicitly requested using a second list area and are separately requested for common and cross (different) cable sequences. Since there is currently no way to simply specify all possible 'n' spacings, make the list as long as necessary to include the data required.

The V and H checkboxes and common and cross cable checkboxes interact. If only common cable is selected, the arrays created have transmitter and receiver dipoles aligned in a single direction (along the common borehole in the case of common cables and at a common elevation in the case of horizontal dipoles). If different cables toggle is set then the transmitter and receiver dipoles cannot be aligned in a straight line. The H and V checkboxes are set independently for the transmitter and receiver permitting 'L' shaped arrays. The V checkboxes result in common cable dipoles. The H checkboxes result in dipoles with matching electrode numbers on two separate cables. If common cables and the V checkboxes are chosen then a traditional array, arranged along a borehole line is sequenced. If  cross  cables and H checkboxes are chosen then 3D horizontal dipoles are collected as shown below.  The display of transmitter and receiver dipoles shown in these figures is accomplished using the Quadrupole View described below.
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[image: image40]
In some cases many boreholes are present, or some are so far apart that creating sequences between them is meaningless. In order to create sequences for sub systems, it is possible to create and work with groups of cables. To create a group simply list the cable ID's  (each cable is determined by an integer number) and click 'add' to add the group to list of groups. Select any group from the list to work with it. The sequence will be created only for cables specified in “List of Groups”.  

Creation of a simple sequence would include the following steps: 
 
[image: image41]
1 – Select the array type using the push buttons (dipole-dipole, wenner etc. - multiple selections are allowed)
 
 
2 – set the transmitter and receiver dipole size [image: image42]and direction [image: image43]parameters. The kGeom. constraint sets a threshold below which quadrapoles will not be generated. This is useful to eliminate quadrupoles that will likely read very small values.
 
[image: image44]
3 – set n list and common or cross cables (or both).
 
 
4 – Push the [image: image45]button to generate the sequence.
5 – Push F11 or select View Quadrupole List from the Sequence menu.
6 – Repeat steps 1-5 to generate as many sequences as required.
7 – Save the sequence. 
 
  
ERTLab Format
 
[image: image46]
 
The ASCII file is divided in two parts. A description of electrode layout and the quadrupoles list. Each section start and ends with e “Tag”
 
	Tag
	Columns

	#elec_start
	 

	 
	N. cable, N. electrode, X, Y, Z coord, Z ground

	#elec_end 
	 

	 
	 

	#data_start
	 

	 
	Progressive, n. cable, A, n. cable, B, n. cable, M, n. cable, N

	#data_end
	 


 
 
IRIS Format
 
[image: image47]
 
 
The ASCII file is divided in two parts. First a description of electrode layout, after the quadrupoles list
 
	Line
	Columns

	1
	Header

	2 to N electrode
	N, X, Y, Z

	3 + number of electrodes 
	Header

	4 + number of electrodes
	N_item, A, B, M, N


 
For input sequence file must have one of the format sketched above. Otherwise an error is generated. 
 
 
 
